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Introduction
The Juker is a versatile jukebox. It can play MIDI (MID) songs, wave audio (WAV) files, movie clips (AVI), 
and other formats supproted by the MCI driver (e.g. FLI, ..etc.). As a jukebox, though, its main purpose is 
playing songs, so all the above formats will be referred to here as songs.

Songs can be queued to play at a sequential or random order. Songs queued can be saved in an album 
and played in later sessions. The Juker saves its settings and window location on exit to use them for the 
next session. It even saves the currently playing song, so you can pick up exactly where you left off when 
you start it again. 

Song progress is shown (and can be controlled) by a moving sound bar. Undesired songs can be 
removed from the queue and optionally deleted from disk. While a song is playing, it can be stopped or 
paused and then resumed.

The Juker is meant to be unobtrusive, it can run all the time as an icon. The animated icon provides a 
pleasant visual feedback on the play progress. Song play can be paused and resumed simply by clicking 
the right mouse button on the icon. The name of the current song is shown in the icon's caption, so it's 
always visible.

When another session of the Juker is invoked while the first is still running, it merely restores and raises 
the first one, no new session is started.

See also: Albums, Animated Icon



Installation
Unpack the distribution archive anywhere you like. The file mmsft.dll must be in the same directory the 
program file is in. Then move ctl3dv2.dll to Windows system directory (e.g. \windows\system) if it is not 
already there, or if it is newer than the copy you have there. Otherwise delete it from the program's 
directory.

Note: Ctl3dv2.dll must reside only in Windows system directory, hence it must be moved there or deleted 
from the program's directory if it is already in Windows system directory.

Windows NT and OS/2 Compatibility
This program runs well under Windows NT 3.1 and OS/2 2.1 as a Win16 application. (Latest versions 
tested: 3.0)



Albums
Albums provide a convenient way of grouping songs into various categories. For example, you might want
to put all your classic music pieces in an album, jazz in another, ..etc. Or, if different people share the 
same machine, each might have his or her own album, which can be tailored according personal taste.

An album is simply a separate song queue. Earlier versions of the Juker allowed only for a single queue, 
which can be considered as supporting only a single album. An album can hold up to a thousand song. 
However, having that many songs may make loading such an album take a relatively lengthy amount of 
time on slow computers (especially if the Allow Duplicates option is disabled). It also defeats the propose 
of the albums (i.e. to organize related songs into logical groups).

When the program is invoked for the first time, is opens a default album. You can create a new album by 
making changes to this album (adding or removing songs from the queue) and then saving it under a 
name you like using Save As. When the program is started the next time, it automatically opens the album
of the last session (unless an album is specified on the command line, see Command Line).

Unless you want to create a new album, you normally need not worry about saving albums. They are 
saved automatically on program exit and when a new album is opened (thus closing the current one). 
Automatic saving can be disabled, however, via the Auto Save Album option.

Albums are loaded by simply dragging an dropping them into the Juker's window or icon. The program is 
smart enough to know whether the dropped file is an album or a song. You can also load an album by 
selecting it from the Most Recent Albums list in the Album menu.

If you do not want to take advantage of albums, you can forget about all the above and use the Juker with
just a single song queue. Albums will be transparent to you in this case, and you need not bother with 
them.



Animated Icon
Since the Juker is meant to be unobtrusive, it is designed to be run most of the time as an icon. When 
minimized, the essential functions of the program can be activated via the system menu or the right 
mouse button (see Mouse Actions actions), and the song play progress is visually conveyed via an 
animated icon.

The icon conveys the song progress by a monotonically increasing background color shade. The 
percentage of the song that has been played is proportional of the size of the icon's background that has 
been shaded.



Command Line
The program accepts a single album file name at the command line. If such an album is specified at the 
command line, that album is loaded on startup instead of last session's or the default album. See 
Invocation Tips for more details.



Invocation Tips
Besides the usual way to starting the Juker (i.e. from the File Manager or Program Manager and then 
dragging an album if one different than last session's is desired), here are some ideas you might want to 
use:

· Highlight any album (ALB) file in the File Manager. Select Associate from the File menu. Click 
Browse, and select the Juker's program file (juker.exe). Click OK. From now on you can start the 
Juker with your favorite album by simply double clicking on that album in the File Manager.

· After doing the above, drag your frequently-used albums to a group in Program Manager. As you drop
each album in the Program Manager, a new entry with the Juker's icon will be created. You can then 
start you favorite album by simply double-clicking on its icon in the Program Manager. 



Other Tips
· Some defective MIDI files can cause the Windows sequencer to freeze while playing those files. You 

may have noticed that when using Media Player, that program sometimes gets stuck on such files. 
The Juker is smart enough to circulate to other songs when one is stuck. You can disable this 
behavior, however, if it causes you any undesirable side effect by adding the statement 
CirculateIfStuck=0 to the [Settings] section of the program initialization file, Juker.ini.

· The Juker automatically saves its settings (and the current album if Auto Save Album is enabled) on 
exit. You can force the program to do that without exiting either by invoking the Save Settings Now 
menu command or by holding down the Shift key while invoking a menu command or a keyboard 
accelerator that normally closes the application (e.g. Exit or Close menu items, or the Alt+F4 
accelerator). The latter, rather non-obvious, method is similar to that of the Program Manager.

· Holding down the Shift key while dropping a song starts playing that song immediately (starts playing 
the first dropped song if multiple songs are dropped). Holding down the Shift key while selecting the 
Add to Album menu command starts playing the added song immediately (starts playing the first 
added song if multiple songs are added).



Album Menu
New
Creates a new empty album. Use Save As to save it under the name you like to give it.

Open
Opens and loads an album from disk. A dialog appears from which an album can be selected.

Save
Saves the current album to disk. If an album by the same name already exits it will be backed up before 
being overwritten. The backup has the same name as that of the album, but ends with a tilde (~) in its 
extension.

Save As
Saves the current album under a possibly different name. Use it to create new albums by saving the 
currently loaded one under a different name. The user is prompted for confirmation if the an album by the 
same already exists (that album will be backed up before being overwritten). Albums must have the 
extension ALB. If the name given has no extension, the appropriate extension will be appended to the 
name

Close
Closes the current album and opens the default one. The default album is called DEFAULT.ALB and 
resides in the directory in which the program resides. Note: Since this function opens the default album, it
has no effect when the loaded album is the default one.

Delete
Closes and deletes the current album and its backup. The album and its backup are physically deleted 
from disk and are lost forever. Hence, use with caution. The user is prompted for confirmation before 
performing this function.

Sort
Sorts the album by song names.

Clear
Removes all songs from the album. Stops song play.

Remove Duplicates
Removes all duplicate songs from the album. See Allow Duplicates for more details.

Note: Invoking this menu command always saves the album prior to removing duplicate songs from it, 
regardless of the state of Auto Save Album.

Properties
Displays the album properties.

Recent Albums
A list of the ten most recently visited albums is shown. Any album in this list can be opened simply by 
selecting it from this list.

Exit
Terminates the program.



Song Menu
Add to Album
Adds songs to the album. A dialog appears from which multiple song files can be selected. An alternate 
(and easier) method of adding songs to the album is by dragging and dropping them to the Juker's 
window or icon, see Mouse Actions. Note that due to limitations imposed by Windows common dialog 
boxes, you may not be able to add a large number of songs (say more than 150) at once using the dialog 
box. If this happens, add the songs in smaller chunks. You can add as many songs you like in one chunk 
using drag and drop though.

Holding down the Shift key while selecting this command starts playing the added song immediately 
(starts playing the first added song if multiple songs are added).

Play
Plays the selected song from the beginning.

Stop
Stops song play. In contrast to Pause, a song that is stopped cannot be resumed, it starts playing from 
the beginning if Play is selected.

Pause/Resume
Pauses the currently playing song, or resumes a paused song (toggle). The current state of this toggle is 
indicated by a check mark.

Repeat
Continuously plays the currently playing song until toggled back. This button is useful if during playing, a 
particular song appeals to you and you want to listen just to it for a while. The current state of this toggle 
is indicated by a check mark.

Circulate
Plays the next song, or the next randomly-selected song if Random Order is checked.

Remove
Removes the selected song from the album, Plays the next song if the selected song is the one currently 
playing. If no songs are left in the album, playing is stopped.

Delete
Deletes the selected song file from disk. Prompts the user for confirmation if Confirm on Delete is 
enabled.

Move Up/Down
Moves the selected song one position up (or down) the list in the album. Note: Holding down the Shift key
while selecting this command moves the song all the way up (or down) the list, i.e. makes that song the 
first (or last) song in the queue.

Highlight Current
Moves the selection highlight to the active (playing or paused) song. If you have selected another song, 
this command is useful to quickly return you to the active song.



Options Menu
The status of every options is saved on exit and used in the next session, so there is no need to adjust it 
on every program invocation. The current state of each option is indicated by a check mark.

Continuous Loop
Continuous play. Loops to the first song when the last one in the queue finishes playing.

Random Order
Plays songs in random rather than sequential order. This also effectively yields continuous play.

Auto Play
Starts playing songs automatically when an album is loaded. Otherwise song play has to be started 
manually after loading an album. The same applies when songs are added to an empty album.

MIDI Auto Reset
Some MIDI songs leave the synthesizer in an unbalanced state after they finish playing (e.g. the volume 
of some channels is left at something other than the default, ..etc.). With this option, the program resets 
the MIDI synthesizer before playing any MIDI file. This option does not affect other multimedia files such 
as WAV and AVI files in any way. This is a useful option to leave on, and is a unique feature of the Juker.

Two levels of reset are available. Standard reset turns off all notes, lifts the sustain pedal, and resets the 
controller for each channel. Full reset also sets the modulation to zero and the pitch wheel to center.

Auto Save Album
Saves the current album on program exit or when another album is opened (e.g. by dragging it to the 
Juker's window or icon).

Save as Relative Paths
Saves song names relative to the album path rather than as absolute paths. Example: if the album is c:\
fun\sounds\albums\classic.alb and a song's absolute file name is c:\fun\sounds\midi\schubert.mid, the 
song will be saved in the album as ..\midi\schubert.mid if this option is enabled. 

This is useful when you want the album to be independent of the absolute path, like when you want to 
distribute and album with it songs. Example: in the above example, you can give the album and its songs 
to a friend and he/she can make the album reside as d:\music\albums\classic.alb and the song as d:\
music\midi\schubert.mid and things will work without changing anything in the album.

Note: Queue display always shows absolute paths, regardless of how the song file name is saved in the 
album. Note also that a relative path is the same as an absolue path if the album and song reside in 
dirfferent drives, so this option is immaterial in such cases.

Allow Duplicates
If unchecked, songs that are already in the album will not be added again upon dropping them into the 
application or opening the album. Otherwise, duplicate songs will be allowed in the album. Uncheck this 
option if you want to make sure no duplicates are allowed in the queue. Note though that this setting is 
not retroactive, i.e. If you already have duplicates in the album, they will no be removed when this box is 
unchecked until you reopen the album.

Note: For large albums and slow machines, disabling (unchecking) this option slows album loading 
considerably. It is recommended in such cases that you leave it enabled and use Remove Duplicates 
when you have reason to suspect there might be duplicate songs in the album, or to disable it only 
temporarily when you are adding songs you suspect are already in the album.



Confirm on Delete
Prompts for confirmation for deleting disk file when Delete is invoked.

Mini-Help
If enabled, a short message describing the highlighted menu item or the selected button is shown in the 
title bar while that menu item is highlighted or the button is pressed. Hence, all buttons and menu items 
are self-explanatory. This option may be turned off once the user masters the functions of the various 
menus and buttons.

Set Font
Sets the font of the album queue list. A dialog appears from which a font can be selected.

Save Settings on Exit
Saves program settings (as well as the current album if Auto Save Album is enabled) on exit. It is highly 
recommended that you leave this option enabled all the time.

Save Settings Now
This is not option, it is a command. It saves program settings (as well as the current album if Auto Save 
Album is enabled) when invoked. You normally do not need to invoke this menu command if Save 
Settings on Exit is enabled.



Self-explanatory.



System Menu
Pause/Resume
Equivalent to Pause/Resume in the Song menu. The current state of this toggle is indicated by a check 
mark.

Repeat
Equivalent to Repeat in the Song menu. The current state of this toggle is indicated by a check mark.

Circulate
Equivalent to Circulate in the Song menu.

Remove
Equivalent to Remove in the Song menu.

Delete
Equivalent to Delete in the Song menu.



Buttons
The program uses smart buttons. A short message describing the selected button is shown in the title bar 
while the button is pressed.

 Play
Equivalent to Play in the Song menu.

 Pause/Resume
Equivalent to Pause/Resume in the Song menu.

 Stop
Equivalent to Stop in the Song menu.

 Circulate
Equivalent to Circulate in the Song menu.

 Repeat
Equivalent to Repeat in the Song menu.

 Add
Equivalent to Add in the Song menu.

 Remove
Equivalent to Remove in the Song menu.

 Delete
Equivalent to Delete in the Song menu.

 Current
Equivalent to Highlight Current in the Song menu.

 Up/Down
Equivalent to Up/Down in the Song menu.



Mouse Actions
Drag and Drop
Dragging a song (MIDI or WAV) file to the Juker's window or icon adds that song to the album queue. If 
the song is already in the album and Allow Duplicates is unchecked, the song will not be added. Dragging
an album (ALB) file closes the currently opened album and opens the dropped album.

Note, however, that although it is perfectly fine to drop multiple songs into the queue simultaneously, you 
may not drop multiple albums, nor albums and songs together.

Holding down the Shift key while dropping a song starts playing that song immediately (starts playing the 
first dropped song if multiple songs are dropped).

Left Button
Clicking the left mouse button on any song in the album selects it. While a song is selected, song 
commands (e.g. Play, Remove, and Delete) apply to it. A song may be selected even though another 
song is playing. Merely clicking the left button only selects the song, it does not play it. Double-clicking the
left mouse button on a song selects the song and starts playing that song from its beginning.

Right Button
Clicking the right mouse button on the Juker's icon or window surface (not on the buttons or the list box) 
is equivalent to selecting Pause/Resume from the Song menu. Holding down the Shift key while doing 
that is equivalent to selecting Repeat. Clicking the right button on any song in the list box selects that 
song and pops up a menu that has a subset of the commands in the Song Menu. You can return to the 
song currently playing by choosing Highlight Current from the menu or pressing Control+H.



Keyboard Actions
Tab
Switches between window groups and group members.

Arrow Keys
Switches between group members. For example, when in the queue list box group, switches between 
songs; when in the Play button group, switches between the three member buttons (Play/Stop, 
Pause/Resume, Stick/Unstick, and Circulate).

Accelerators
There are also keyboard accelerators for the more frequently-used menu commands (e.g. F1 for Help 
Contents, ..etc.). These are shown on their corresponding menu items. Moreover, when the album list box
has the focus (you change the focus to it either by clicking anywhere inside it, or by pressing Tab a few 
times to switch to it), the selection highlight can be moved quickly to any song by pressing the first 
character in its name. Pressing more than once moves the selection highlight to the next song that begins
with that letter.

Keyboard Modifiers
Some mouse actions, keyboard accelerators, and menu commands perform different functions depending
on the state of the Control or Shift keys. These are mentioned in the appropriate section for each. Here is 
a sample:

Action Modifier New Effect
Drag and Drop Shift Plays the dropped song immediately
Add to Album Shift Plays the added song immediately
Up/Down Shift Moves the song all the way up (or down) the 

queue, instead of just one position
Right Mouse 
Button

Shift Equivalent to selecting Repeat

Exit, Close Shift Equivalent to selecting Save Settings Now
Alt+F4 Shift Equivalent to selecting Save Settings Now

Track Bar
The track bar shows the current position in the song being played. This position can be changed by 
dragging the slider of the track bar. While dragging the slider, the destination position is shown (in 
seconds) in the status bar. The song can also be advanced or receded 1% by the end arrows, or 10% by 
clicking in the area between them. The keyboard can also be used.

Moving the slider in any fashion automatically resumes playing a paused or stopped song.



Digital Console
The digital console displays important information about the song play progress, album characteristics, 
and selected options. 

The LCD digits display the following, respectively:
· Current time position in the song.
· Length of the song in minutes.
· Song number.
· Total number of songs in the album.

The buttom row indicates whether the following is true, respectively:
· Song is playing.
· Song is paused.
· Repeat is active.
· Continuous Loop is active.
· Random Order is active.



Title Bar
A short message describing the highlighted menu item or the selected button is shown in the title bar 
while that menu item is highlighted or the button is pressed. Hence, all buttons and menu items are self-
explanatory. This behavior can be turned off using Mini-Help from the Options menu.

Moreover, during time-consuming operations (e.g. loading or saving an album, loading a song, ..etc.), a 
brief message describing the current task being performed is displayed in the title bar.



Please refer to the Installation section in this help file.



Registration
This software is provided as shareware. If you use this program on a regular basis (say for more than two 
weeks), you are requested to register it. The registration fee is not much, about what you would pay for a 
decent meal in a respectable restaurant (no, McDonald's does not qualify :-). Basically, the registration fee
is:

· $10 for this program alone, or
· $15 for both this program and A-B-CD

You can use whatever method of payment you like. Inside the US, probably the easiest way for you is via 
a personal check or money order. Outside the US, you can just send cash. Wrap the cash in a piece of 
paper or use a thick envelope, so that it won't be stolen. You don't have to use US dollars, use whatever 
its equivalent of your currency -- I might just keep it as a collectable.

Make the registration fee payable to M. Saggaf, and send it to this address:

M. Saggaf
262 Sidney St. Apt. #3
Cambridge, MA 02139
U.S.A.

email: alsaggaf@mit.edu

If you access to ftp, The latest version of the program should be available by ftp at 
ftp.cica.indiana.edu.



Super multimedia audio CD-ROM player and database for Windows. Uses an interface similar to this 
program. Should be available at the same site you got this program from.



Shareware distribution gives users a chance to try software before buying it. If you try a    Shareware 
program and continue using it, you are expected to register. Individual programs differ on details -- some 
request registration while others require it, some specify a maximum trial period. With registration, you get
anything from the simple right to continue using the software to an updated program with printed manual.

Copyright laws apply to both Shareware and commercial software, and the copyright holder retains all 
rights, with a few specific exceptions as stated below. Shareware authors are accomplished 
programmers, just like commercial authors, and the programs are of comparable quality. (In both cases, 
there are good programs and bad ones!) The main difference is in the method of distribution. The author 
specifically grants the right to copy and distribute the software, either to all and sundry or to a specific 
group. For example, some authors require written permission before a commercial disk vendor may copy 
their Shareware.

Shareware is a distribution method, not a type of software. You should find software that suits your needs 
and pocketbook, whether it's commercial or Shareware. The Shareware system makes fitting your needs 
easier, because you can try before you buy, and because the overhead is low, prices are low also.    
Shareware has the ultimate money-back guarantee -- if you don't use the product, you don't pay for it.



License Agreement
This software is provided as shareware. You are encouraged to use this program on an evaluation basis 
and pass it along to friends and upload it to bulletin board systems. This program may not, however,    be 
disassembled, decomposed, reverse engineered, or altered in any way, nor any of the other files in the 
package. This includes, but is not limited to, modifying any icons, menus, or displays associated with the 
software.

This software may not be sold. This restriction, however, does not apply to connect time charges, 
download fees, or reproduction charges. This software may not be bundled with any commercial package 
without the explicit written permission of the author.

The author of this program disclaims all warranties with regard to this software, including all implied 
warranties of merchantability and fitness. In no event shall the author be liable for any special, indirect, or 
consequential damages or any damages whatsoever resulting from loss of use, data, or profits, whether 
in an action of contract, negligence, or other tortuous action, arising out of or in connection with the use or
performance of this software.



Revision History
Version 4.4
· Added new menu item: Close Album
· Fixed memory management of user interface objects. They are no longer deleted twice.
· Reorganized the song information display procedures.
· The timer message handler now handles re-entrance properly.
· Now uses ctl3dv2.dll instead of ctl3d.dll. Much better and setup hassles.
· Main window is now inactive (disabled) during lengthy operations like saving and loading an album.
· Now uses owner-draw list boxes to place song display fields correctly, regardless of the font used.
· Added small bitmap in the queue list.
· Now uses Shift as well as Control as keyboard modifiers. Eventually, use of Control will be phased 

out.
· Added new menu item: Delete Album. Deletes an album and its backup. Use with caution.
· Added new option: Save as Relative Paths. Save song names relative to the album path instead of 

using absolute path names.
· Fixed a bug that would cause an album to be saved in a different (wrong) directory if its path is 

unknown.
· Fixed the meaning of the default album. The default album is now unique.
· Auto-Play now affects also dropped songs and the Add to Album menu option.
· Addedd Album Properties to the Album menu, to display album information.
· Improved the application icon.

Version 4.2
· New Auto-Play option, to control whether song play should start automatically on program start.
· Frames are now painted in a different, more robust way.
· New Digital Console to show album information and song progress, replaces the status bar.
· New bitmap buttons. No more text buttons.
· Play and option-states (play/pause/etc.) are now shown on the digital display.
· Buttons, like menu options, now show mini-help message,.
· Auto Save Album is now honored even if Save Settings on Exit is disabled.
· Mini Help option toggle (to disable or enable Mini-Help) is now shown on the Options menu.
· Renamed Stick to Repeat.
· Now the queue list does not update while loading an album.
· Added a new item in the Options menu: MIDI Auto Reset -- to reset the MIDI synthesizer before 

playing each song..
· Fixed a bug that would cause the slider in the track bar to move erroneously when it is repositioned.
· Fixed a bug that would cause the program to circulate to the first song if it fails to play any song in the

queue.
· Holding down Shift while choosing Move Up/Down now moves the song all the way up (or down) the 

queue.

Version 4.0
· First ImposterWare release.
· New animated icon (has 3D frame, and song progress is now indicated by a growing color shade 

background).
· Corrected Remove Duplicates when Auto-Save Album is disabled. Was not working properly in that 

case.
· Control and Shift modifiers now work properly under Windows NT.
· New 3D look with a chiseled frame.
· Cleaned up the code quite a bit and now uses objects more extensively.
· The About box is now displayed inside the screen even if the main window lies outside it.



· Fixed a bug related to freeing character aggregates that would have caused heap corruption.
· The newest version (2.04) of ctl3d.dll is now included with the program.
· The program now recognizes if an older incompatible ctl3d DLL is installed and loaded, and warns the

user accordingly.
· When adding songs to the album via the Add to Album menu command, the number of songs that can

be added at the same time is now much larger.
· Fixd a bug that caused a confirmation box to be displayed even if Confirm On Delete is disabled.
· Changed the logic of Pay/Sop. Now they are decoupled.
· Changed the logic of mouse clicks in the list box. Now selecting a song does not automatically play it.
· Mini-help now shown in the window title instead of the status bar.
· Some minor appearance changes (e.g. the Stick button is now flush left).
· Remove Duplicates moved to album menu.
· Confirm Deletions was renamed to Confirm On Delete.
· Fixed a bug that might cause the wrong song to be deleted when Delete is selected.
· The title bar now displays a brief message describing the current task being performed (e.g. loading 

or saving an album, ..etc.).
· The program's window is now    displayed as soon as the program is invoked, not after the album is 

loaded (better feedback).
· Menus and buttons are now inactive during album loading.
· Fixed numerous memory leaks.
· Added a new button 'Current'', equivalent to the Highlight Current menu item.
· The Juker now plays AVI movie clips.
· Number of saved albums changed to 9.
· Album Queue has been enlarged to make more songs visible.
· Moving the track bar when a song is stopped now starts playing the selected song.
· Cleaned up the program's interaction with the MCI driver.
· Implemented New in the Album menu, to create a new album.
· Added Change Font to the Options menu -- the album queue font can now be changed.
· Confirm on Delete message is now more readable.
· New look with a vertical geometry. Looks and functions better.
· Changed the way the program interacts with the timer (continuous use instead of frequent start/stop).
· Many other small changes, enhancements, and bug fixes.

Version 3.0
· Mini-help is implemented. A short message describing the highlighted menu item is shown on the 

status bar while the item is highlighted.
· The programs's window now looks more 'composed' while loading an album or adding songs to it.
· New icon for the help file when minimized.
· Added ShowMiniHelp in the Settings section of the profile (but not shown on the menus).
· The program now waits a bit longer (10 seconds versus 5) before circulating on songs that are stuck.
· Added Save Settings on Exit option.
· Added Save Settings Now menu command.
· Pressing Shift while selecting Exit or Close, or while pressing Alt+F4 is now equivalent to Save 

Settings Now (like the Program Manager).
· Holding down Control while dropping a song now starts playing that song immediately. Also true if 

Shift is held down while selecting the Add Song menu item.
· Added Remove Duplicates Now menu command.
· Control + Right Mouse Button now toggles Stick.
· Fixed a bug that prevented the program from saving its settings at the end of the Windows session
· Fixed a bug that hindered circulating on stuck songs.
· Albums are now backed up when saved.
· Fixed a small bug that caused the cursor (pointer) not to be resotred properly after being changed to 

the hourglass cursor.
· Recent Albums menu is now handled differently (as a separate popup menu).



· Added Sort album menu command.
· Increased the recent album list to 10 albums instead of 5.
· Fixed a bug that caused current song position display to increment by 2 seconds instead of each 

second
· The user is now told if a non-existent album is selected from the Recent Albums list, instead of just 

silently ignoring the request.

Version 2.6
· Fixed a bug that caused the song playing to restart from beginning if another is added to queue.
· Fixed a bug that caused the song name to disappear from the window caption and status bar when 

the album is saved.
· Added keyword search to the help menu.
· Added keyboard accelerators for frequently-used commands.
· You can now save the program's profile (settings) by pressing Shift+Alt+F4, just like the Program 

Manager.
· Added CirculateIfStuck in the Settings section of the profile (but not shown on the menus).
· Renamed Continue to Resume.
· The icon box now looks more 3D-like.

Version 2.5
· The program now uses menus. Most of the less-used functions as well as all the setup options have 

been moved to the menus.
· Clicking the right mouse button on the window surface (not the buttons or the list box) now functions 

like it does on the icon (i.e. invokes Pause/Continue).
· New functions: Open Album. For those who don't like opening albums by dragging and dropping them

into the Juker's window or icon.
· New functions: Add Song to Album. For those who don't like adding songs by dragging and dropping 

them into the Juker's window or icon.
· Moved less frequently-used buttons to the menus.
· Moved the setup area to the menus.
· Removed the Most-Recent-Albums combo box and added an equivalent (and more standard) 

replacement to the Album menu.

Version 2.3
· Added Up/Down buttons to move songs in the album.
· Most Recent Albums now appear in an easily-accessible combo box so that they can be opened 

easily.
· Changed the logic of the Play/Stop/Pause buttons to be easier.
· Animated icon now behaves more correctly (smoother motion).
· Album name is now displayed in the window and icon captions.
· Now shows free memory and resources in the About dialog box.
· Setup area now opens and closes to reduce clutter.
· New setup check box: Allow Duplicates. Uncheck to prevent duplicate songs in albums.
· New button layout
· No longer gets stuck if a bad MIDI file is loaded (beats all other players, even Microsoft's!)
· Now adds an extension to the file name in SaveAs if none is givem.
· Now prompts in SaveAs if the album already exists.
· Now shows an hourglass cursor when busy.
· Popup error messages are now accompanied with a beep.
· Tidied up the help file a bit.
· The help file audio welcome message is now played correctly even if the current directory of the 

program is on another drive.



· The slider of the Track Bar is now fully functional, and can be used to move back and forth in the song
being played.

Version 2.1
· Fixed a bug in Album*Save functin.

Version 2.0
· Removed Size and Maximize from the system menu since they're not needed here.
· Now the program itself paints the icon, instead of letting Windows do it. More flexible this way.
· Added an animated icon that provides a good visual feedback of song progress.
· Introduced albums. Now different song queues can be saved and retrieved at will.
· Maximum number of songs saved in a queue (album) is now 1000 instead of 100.
· Replaced Save Queue on Exit by Auto Save Album.
· Added a survey to the archive. To be filled by interested users for feedback on the program and 

suggestions for improvement.
· The program now accepts an album file name on the command line and will load it on startup if 

specified.
· Beefed up the help file quite a bit. Even added a sound clip.
· The program can now play WAV files as well.

Version 1.4
· The program now uses a private initialization file (Juker.ini). Program information left in win.ini by a 

previous version will automatically be cleaned by the new version. Win.ini is no longer used by the 
Juker. Using a private initialization file is faster, reduces the clutter in win.ini, and is in accordance with
Windows guidelines.

· Fixed the keyboard interface, which was broken in the previous version. Also, all buttons are now 
accessible by the tab key. Much more intuitive this way.

· Some appearance changes (frames around the windows).
· Now saves and restores the stick state.
· Added upgrade information dialog box, to alert the user to important release notes.
· Fixed a bug in pause/resume that would cause the next song not to play if the current one has been 

paused then resumed.
· The Juker's window no longer sizes, since it's not supposed to.
· Added an informative status bar at the bottom of the window.
· Added Circulate, both as a button and in the system menu.

Version 1.2
· Window and icon captions are now in capitals. Easier to read when iconified.
· The program now starts at the song it was playing on exit in the last session.
· Clearing the queue or removing the last item now stops song play.
· Added stick/unstick as a button and in the system menu.
· Unified the play and pause buttons.
· Full song name are now aligned as a table to make it easier to read the song name.
· Cleaned up the keyboard interface (tabs and arrow keys) to make it easier to use the program with 

just the keyboard.
· Now consumes virtually no CPU time.

Version 1.1
· Second invocation of the program restores (if iconic) and raises first one. Does not start a new 

instance.



· More object-like (check boxes, ..etc. are now implemented as objects).
· Added help and activated the help button.
· If Random Order is checked, the program plays a random first item when starting (if some songs are 

present in the queue).
· Closing the program from the system menu now saves the profile.
· Added Delete button (remove disk file) and Confirm Delete check box.
· Added Remove and Delete to system menu.
· New 3D look using ctl3d.dll.
· Clicking the right mouse button on the icon now toggles pause/play.
· Song names are shown differently in the queue so that the base name of the file is always visible, 

even if the full song path name is too long. 
· The program now remembers its position even if it closed while iconified.
· Smaller window and fonts
· Rearranged the placement of the buttons.
· Now uses time as the sequence format.
· Songs names are now displayed in lower case.
· The sound thumbnail is now unresponsive to mouse events.

Version 1.0b
· Initial release.




